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Chapter

Surgical Planning and Additive 
Manufacturing of an Anatomical 
Model: A Case Study of a Spine 
Surgery
Levent Aydin, Ozgur Cakir, Riza Dilek and Mucahit Ege

Abstract

3D scanning technologies have promising solutions for medical needs such 
as anatomical models, biocompatible implants, and orthotic/prosthetic models. 
Although virtual presurgical planning offers more precise results, it may not be 
applied in every hospital because of the high costs. The aim of this study is to assess 
the accuracy of the suggested low-cost and effective surgical planning method by 
means of additive manufacturing to increase success rate of each surgery. In this 
study, a full spine model of a scoliosis patient was acquired and reconstructed in 
MIMICS software using different filters and parameters. Therefore, a comparison in 
terms of geometrical errors among each model was performed based on a reference 
model. Subsequently, patient-specific full spine model was manufactured using 
a three-dimensional printing method (fused deposition modeling) and utilized 
before the surgery. 3D surgical model reconstruction parameters such as wrap tool, 
binomial blur, and curvature flow filters produced high geometrical errors, while 
mean filter produced the lowest geometrical error. Furthermore, similarity results 
of the curvature flow and discrete Gaussian filters were close to mean filter. Smooth 
tool and mean filter produced almost the same volume of the reference model. 
Consequently, an ideal protocol for surgical planning of a spine surgery is defined 
with measurable accuracy. Thus, success rate of a spine surgery may be increased 
especially for the severe cases owing to the more accurate preoperative review: 
operability.

Keywords: additive manufacturing, image guided surgery, orthopedic surgery, 
surgical planning, accuracy assessment, scoliosis

1. Introduction

Scoliosis is a three-dimensional (3D) deformity in the natural shape of spine that 
requires surgery in serious cases [1]. A lateral deviation of the spine greater than 
10 degrees is accepted as scoliosis and an abnormal sideways curvature is observed 
from the frontal plane of a patient, while a healthy spine should look like straight 
[2, 3]. Although hereditary factors play a role in the etiology, most of the cases 
(80% of the patients) with unknown cause are called idiopathic scoliosis and clas-
sified into three main groups based on the age, namely, (i) infantile (up to 3 years 
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old), (ii) juvenile (4–9 years old), and (iii) adolescent (10 years old to teen years) 
[4]. The severity of scoliosis is also determined by Cobb method that provides 
obtain information about the curvature of the spine in terms of degrees. According 
to these measurements, a scoliotic curve of the spine is defined as (i) mild scoliosis 
(10–25°, requires monitoring), (ii) significant scoliosis (25–40°, treated with brac-
ing), and (iii) severe scoliosis (over 40°, requires surgery) [5]. Recently, a number 
of the scoliosis patients are growing up to 2–3% worldwide due to the unawareness 
of people [6]. It is important to predict risk of progression, diagnose at early stage 
for preventing degenerative effects, and contribute to the patient’s quality of life. 
Unfortunately, in some cases, rapid progress on spine deformity or late diagnosis is 
resulted with surgical operations that are necessary to stabilize the spine by means 
of rod placement on each affected vertebra [6]. All operations require precise 
processes in a limited workspace because of the spinal nerves and blood vessels. 
Besides, an injury of a vessel around the surgical site may initiate clotting that may 
result with pulmonary embolism or even death [7]. Therefore, novel technologies 
and methods are of great importance to assist or plan the surgery in advance.

Medical imaging technologies such as multidetector computed tomography 
(MDCT) and magnetic resonance imaging (MRI) are rapidly evolving to visual-
ize more complex tissues of the human body [8]. Furthermore, high-resolution 
images provide radiologists more accurate diagnosis [9]. Although 3D visualization 
of the scanned tissues simplifies the surgical procedures, patients may undergo a 
suboptimal outcome after the treatment [10]. On the other hand, two-dimensional 
(2D) computer screens prevent the direct interaction with the target 3D model 
[11]. While virtual presurgical planning offers more precise results and overcomes 
mentioned drawbacks above, it is not applicable for every hospital because of its 
high costs [10]. Additive manufacturing, layer-by-layer fabrication of a physical 
object, is increasingly being used especially in the fields of medicine. Nowadays, 
these technologies are utilized with medical imaging to produce patient-specific 
(i) medical devices, orthosis, and prosthesis [12], (ii) anatomical to assist-surgical 
models [13], (iii) body parts [14], (iv) dental and maxillofacial implants [15], (v) 
blood vessels [16], and (vi) organs [17]. Typical 2D digital imaging and communi-
cations in medicine (DICOM) files from the CT or MRI images are transformed into 
a 3D standard tessellation language (STL) file to perform 3D printing of the target 
model. A wide range of polymers including glass, ceramic, metal, or biological 
materials may be used to create complex models in a cost-effective way compared to 
conventional manufacturing methods [18]. Although the latest innovative stud-
ies are focused on a functional tissue or even an organ printing, clinical bedside 
applications of these technologies are difficult and limited [11]. On the other 
hand, surgical planning or patient-specific implant production via 3D printing is 
available for any case and widely used to manage a complex surgery or achieve the 
exact placement of an implant [18]. Consequently, success rate of each surgery is 
significantly increased as well as it becomes minimally invasive and requires shorter 
recovery owing to the preoperative review [19, 20].

Surgical planning by means of additive manufacturing consists of five basic 
steps, namely, (i) data acquisition, (ii) image segmentation, (iii) 3D model recon-
struction, (iv) 3D printing, and (v) preoperative review [21]. In data acquisition 
step, a medical imaging system such as CT is used to obtain 2D DICOM images in 
general. The accuracy of surgical planning is first dependent on the contrast-to-
noise ratio (CNR) of scanned raw images [22]. High CNR values provide detailed 
segmentation before the 3D reconstruction of a model. These images are then pro-
cessed via a commercial (Materialize Mimics) or an open-source (InVesalius) medi-
cal image processing software using the default segmentation functions or manual 
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selection of the region of interest on each image during the segmentation step. 
Thus, the target anatomical model’s contour is masked on each image section. In 3D 
model reconstruction step, the mask images are positioned sequentially to form a 
solid model in 3D workspace of the software. Tissue-specific filters or data sets may 
be applied to minimize noise using predefined thresholds before and after the 3D 
reconstruction process. The solid model is exported as a STL file and prepared to be 
3D printed. In 3D printing step, the STL file is 3D printed using one of the addi-
tive manufacturing methods such as fused deposition modeling (FDM), selective 
laser sintering (SLS), or stereolithography (SLA). In a preoperative review step, 
the printed model is evaluated and used before and during the surgery (requires 
sterilization) as a reference model that guide the operation as well as it can be used 
for custom implant or assistive surgical apparatus creation such as drill guides [23]. 
Since surgical planning is important and plays a crucial role during the surgery, 
reference 3D model requires to be created with minimal geometrical errors. The 
accuracy of 3D reconstructed models can be analyzed by calculating the Hausdorff 
distance (HD) and dice similarity coefficient (DSC) values for each model [24, 25]. 
While DSC measures the volume overlap between two models that ranges from 0 
(no overlap) to 1 (exact overlap), HD calculates the Euclidean distance between 
each binary volume [26, 27]. Furthermore, several methods (geometric distance, 
roughness, structure, saliency, and strain-energy-based calculations) may be imple-
mented to assess visual quality and accuracy of the 3D models [28]. In this study, 
a spine model of a scoliosis patient is first acquired and then 3D reconstructed in 
MIMICS software (manual and automatic segmentation) using different filters 
and parameters to compare each geometrical error. The results of the DSC and HD 
values of each reconstructed model reveal the ideal protocol for surgical planning of 
a spine surgery and determine the accuracy of the created model.

2. Material and methods

A 6-year-old patient (male) who has a congenital scoliosis history participated 
to this study for obtaining raw image data. Medical scanning process was performed 
at the Radiology Department, Faculty of Medicine Kocaeli University, using a CT 
scanner (Aquillion 64, Toshiba Medical Systems, Tokyo, Japan). Ethical permission 
was received by the Ethics and Research Committee of Kocaeli University (refer-
ence number, KU GOKAEK 2019/204). A full spinal CT scanning was performed at 
2 mm of slice thickness, 140 mm field of view (FoV) and 135 kV (40 mA, 1 s). Raw 
DICOM images (449 slices) were obtained from the picture archiving and commu-
nication system (PACS) server of the Radiology Department (Figure 1(a)). Thus, 
data acquisition process, the first step of the surgical planning, was completed.

MIMICS software (v19) was utilized in image segmentation step, and a refer-
ence model was automatically reconstructed via MIMICS without any filters 
(Figure 1(b)). DICOM files (449 images) were imported, and segmentation process 
was performed using the thresholding tool at predefined threshold set of the bone 
(226, Hounsfield Unit, HU as lower threshold, and 3071 HU as higher threshold). 
These parameters were ideal to obtain exact contour of the target model in a 
maximum allowable noisy form according to the raw DICOM images for this case. 
Segmentation step was completed after each image section was masked and high-
lighted by a different color (Figure 1(c)).

3D calculation function was utilized at high quality to reconstruct the 3D 
raw surface, and a quite noisy model was created with desired contour based on 
the masked images in 3D model reconstruction step (Figure 1(d)). Each image 
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was positioned sequentially to form a 3D raw model of the spine. Since there 
was noise in the workspace and model’s surface, the 3D raw model was directly 
exported to 3-matic software (v11, Materialize) for manual surface reconstruc-
tion and noise elimination (Figure 1(e)). The surface geometry of the model 
was manually revised, and the noise was manually cleared via 3-matic software 
according to the raw image geometries in MIMICS. Polygon area mark tool under 
the Mark—Area Mark menu was used to select each noisy surface and subse-
quently deleted. The gaps of the deleted surfaces were marked as bad contours on 
the 3D raw model. The bad contours were then selected and fixed, respectively, 
using the Fill Hole Freeform tool under the Fix menu. The Fill Hole Freeform 
process was performed at medium triangulation quality and created in tangent 
form. After manual surface reconstruction, the Fix Wizard tool under the Fix 
menu was utilized to fix geometrical normals, stitching, noise shells, holes, tri-
angles, overlaps, and shells on the model. The errors were automatically fixed by 
clicking Follow Advice, Apply, and Update buttons, respectively, for each option 
(Figure 1(f )). Finally, the patient ID was added using the Quick Label tool under 
the Finish menu. Thus, 3D-reconstructed reference surgical model was obtained 
and exported as STL file by clicking File, Export, and STL buttons, respectively. 
The reference model was exported at binary format and one scaling factor. Some 
sharp cornered bonded surfaces that occurred by Fix Wizard tool during the 
fixing process were also revised in Meshmixer (v3.4.35, Autodesk) manually to 
obtain exact geometry of target anatomical model. Robust Smooth tool under the 
Sculp – Brushes menu was used (brush parameters, 10 strength, 10 size, 0 depth, 
and 0 laziness) to fix sharp surfaces (Figure 1(g)). The 3D model reconstruction 
step was completed after the reference model has taken its final shape (48 hours 
of work). 3D reconstruction of the reference surgical model is illustrated step by 
step in Figure 1.

Test models were separated into three groups, namely, (i) preprocessed, 
(ii) post-processed, and (iii) fully processed models. Preprocessed models 
were obtained using the filtered DICOM images before the segmentation step 
without any post-process in MIMICS. Post-processed models were created from 
the raw DICOM images and only processed via 3-matic after the model was 

Figure 1. 
3D Surgical model segmentation of the reference model (a) An image of the 3D raw model, based on non-
filtered DICOM images in Sectra workspace, a 3D DICOM viewer of the default system software that does not 
allow 3D model exporting or processing, (b) Importing non-filtered DICOM images in MIMICS,  
(c) Segmentation of each image and obtaining the exact contour of target model in a maximum allowable noisy 
form in MIMICS, (d) 3D reconstruction of the raw DICOM images in a noisy form via MIMICS, (e) Manual 
noise cleaning in 3-Matic, (f) Manual surface reconstruction and fixing the geometrical errors of 3D raw 
model in 3-Matic, (g) Fixing the sharp cornered bonded surfaces in Meshmixer.
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reconstructed (Figure 2(a)). Fully processed models were formed with a com-
bination of both processes. Five different image filters of MIMICS, (i) binomial 
blur (Figure 2(b)), (ii) curvature flow (Figure 2(c)), (iii) discrete Gaussian 
(Figure 2(d)), (iv) mean (Figure 2(e)), and (v) median (Figure 2(f )), were 
applied on the raw DICOM images, respectively, and then the segmentation step 
was performed separately for each sample on preprocessed models. Two differ-
ent 3D tools of 3-matic, (i) Smooth (Figure 2(g)) and (ii) wrap (Figure 2(h)), 
were utilized separately for each sample in post-processing case. Preprocessing, 
post-processing, and full-processing parameters of the 3D reconstructed surgical 
models are given in Table 1.

Before the calculation of HD and DSC values by CloudCompare software, 
each spine model was processed via 3-matic software that was necessary to 
determine the spine regions equally on each sample model and obtain more 
correct results in accuracy assessment. Therefore, the spine sections of each 
model were extracted manually and exported using the default options. All test 
models were imported into the CloudCompare software (v2.11, Open Source) 
and then compared with the reference model in terms of the HD and DSC 
results [29]. The best results of the preprocessing and the post-processing cases 
were combined and applied together to form the fully processed model. Finally, 
the fully processed model was compared to the reference model to reveal the 
ideal solution for 3D surgical model reconstruction. Each generated test model is 
illustrated in Figure 2.

HD of the test models was calculated by means of importing and analyzing the 
3D models, the reference model and one of the test models at the same time, in 
CloudCompare workspace. Both models were then aligned using Registration Match 
bounding function—under the Tools menu. This process is required to align the 
box centers (volume frames) of models before performing any similarity function 
in order to obtain accurate results. Fine registration function under the Tools—
Registration menu was applied on each model to highlight the difference of point 
clouds without any scale adjustment. The fine registration function also applies a 
rotation to compared model (generates a rotation matrix with a theoretical overlap 
value) to provide an ideal Overlap in volumes of the both reference and compared 
test model. Finally, HD value (mean distance) was computed via Distances—Cloud/
Mesh Dist under the Tools menu. DSC values were calculated similarly via importing 

Figure 2. 
Reference model and each generated 3D test model with a local mesh view (a) Reference model, (b) Binomial 
blur filter in MIMICS, (c) Curvature flow filter in MIMICS, (d) Discrete gaussian filter in MIMICS,  
(e) Mean filter in MIMICS, (f) Median filter in MIMICS, (g) Smooth function in 3-Matic and (h) Wrap 
function in 3-Matic.
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the reference model and a test model into the 3D workspace of CloudCompare soft-
ware. The match bounding and fine registration steps were also performed to obtain 
perfect alignment. After the alignment process, a plugin named as Cork, under the 
Plugins menu, was utilized to obtain the intersection of both models in terms of 
volume (cube units). Each volume was also measured by means of the mesh mea-
sure volume function under the Edit menu. The DSC value of each model was then 
calculated to obtain overlapped volume between the two models according to the 
formula given below (α = total volume of the reference model, β = total volume of 
the compared model, and α ∩ β = intersection of both models in terms of volume):

  DSC  (α, β)  =   
2  (α ∩ β) 

 _ 
α + β

    (1)

3. Results

Wrap tool, binomial blur, and curvature flow filters produce high geometrical 
errors, while mean filter produces the lowest geometrical error. Furthermore, HD 
and DSC results of the curvature flow and discrete Gaussian filters are close to 
mean filter. Smooth tool and mean filter produce almost the same volume of the 
reference model. However, binomial blur filter and wrap tool generate unacceptably 
different volumes. Moreover, the DSC results of the both mentioned functions are 
not overlapping properly. Each result is illustrated in Table 2.

Smooth and wrap tools generate undesired mesh structures caused by the noise 
during the segmentation step in MIMICS. HD results of each test model are illus-
trated in Figure 3.

Pre-processing parameters of applied filters in MIMICS

Model no. Filter name Parameter Value

1 Binomial blur Number of 

iterations

5

2 Curvature flow Time step 0.5

Number of 

iterations

5

3 Discrete Gaussian Gaussian 

variance

5

Max kernel 

width

5

4 *Mean Filter radius 3

5 Median Filter radius 3

Post-processing parameters of applied tools in 3-matic

6 *Smooth Smooth factor 1

7 Wrap Gap closing 0.05

Smallest detail 0.5

Full-processing parameters of both applied filter and tool

8 *Mean with *Smooth together Filter radius 3

Smooth factor 0.5

(* = best similarity results).

Table 1. 
Parameters of each applied filters and tools.
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HD and DSC results of each test model

No. Filter-tool name Filter 

type

Model 

volume 

(cube 

units)

Max error (%) HD (mm) DSC (0–1)

1 Binomial blur Pre 80393.9 9.502507 1.083704 0.547654

2 Curvature flow Pre 81445.2 8.31908 1.107846 0.923381

3 Discrete 

Gaussian

Pre 81787.5 7.933765 1.034391 0.911621

4 Mean Pre 82308.1 7.347738 1.041506 0.913479

5 Median Pre 79867.7 10.09483 1.043368 0.911775

6 Smooth Post 90480.1 −1.851286 1.185564 0.937718

7 Wrap Post 113,092 −27.30496 0.461971 0.871986

8 Mean + Smooth Together 82231.4 7.434077 1.041154 0.916657

Reference model volume (cube units): 88835.5

Table 2. 
Results of each applied filters and tools (DSC value: 0 = no overlap, 1 = exact overlap, negative max error 
values indicate a larger volume than the reference model while positive values mean a lower volume according 
to the reference model in terms of cube units).

Figure 3. 
The intersection of reference model and each generated 3D test model with a local view (a) Reference model 
and Binomial blur pre-filtered test model, (b) Reference model and Curvature flow pre-filtered test model, (c) 
Reference model and Discrete gaussian pre-filtered test model, (d) Reference model and Mean pre-filtered test 
model, (e) Reference model and Median pre-filtered test model,( f) Reference model and Smooth post-filtered 
test model and (g) Reference model and Wrap post-filtered test model.

Figure 4. 
Results of each produced model. (a) Reference model, (b) Mean filter and (c) Smooth tool.
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The results of the last case given in Table 2 (mean filter with Smooth tool 
together) show that increased Smooth provides to obtain better HD and DSC results 
when compared to the fourth test case (mean filter only). However, the max error 
is proportionally increased with the Smooth tool. Reference model, mean filter, and 
Smooth tool results are illustrated in Figure 4.

4. Discussion

According to the results, binomial blur filter, median filter, and wrap tool are 
not suitable for surgical planning of a spine model due to the high error percent-
age in volume. These functions produce misleading information when used alone 
and may be used with another filter together at lower parametric values. Although 
Smooth tool provides better DSC result than the curvature flow filter, mesh surface 
improvement should not be performed by means of this tool only because of the 
undesired mesh structures caused by the noise. Therefore, a prefilter-like curvature 
flow, discrete Gaussian, or mean should to be applied on raw DICOM images to 
filter noise more accurately during the segmentation step, and Smooth tool should 
to be used at lower values after 3D model reconstruction process. It should be noted 
that some geometrical errors may not be fixed via 3-matic software and may require 
a third party software such as Geomagic Design X or Autodesk Meshmixer. On the 
other hand, fractured or unbounded bone structures may be lost during the noise 
filtering process. Therefore, some functions such as largest surface selection in 
MIMICS should not be used in complex cases, and target model should be cleared 
manually after the 3D reconstruction process. Mesh distribution of the models 
require to be uniform to perform a healthy DSC calculation. Both reference and 
compared test models may be processed via optimize mesh tool in Geomagic Design 
X to achieve uniform mesh distribution on each model.

While software optimizations may be performed to obtain an ideal protocol, 
improvements may also be applied on used CT device at the beginning for more 
correct presurgical planning. Devices with more advanced detector structure, which 
could provide to operate at lower voxels and have high beam quality, may reduce noise 
on raw data images. For example, it is known that dual energy computed tomography 
(DECT) is more suitable for tissue segmentation than single-energy computed tomog-
raphy (SECT) [30]. Besides, some known sources of noise (beam hardening, partial 
volume effect, etc.) can be reduced by making some adjustments before imaging such 
as in monochromatic X-ray, reduced beam hardening effect and thin section thick-
ness, and reduced the partial volume effect, which are very important for spine imag-
ing [31, 32]. Additionally, using higher tube current provides sharper image because 
of the amount of beam delivery to the target tissue. However, high current may not be 
applied in all cases because of the increased radiation dose given to the patient.

5. Conclusion

In this study, an ideal protocol for surgical planning of a spine surgery is defined 
with measurable accuracy. Thus, success rate of a spine surgery may be increased 
especially for the severe cases owing to the more accurate preoperative review.
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